Here’s how to:
MASTER THE THREE ESSENTIAL TOOLS
FOR UNLOCKING THE SECRETS OF
WINDOWS 10
Taskbar, File Manager, and Edge Browser
SECTION ONE: WHAT YOU WILL WANT TO KNOW ABOUT THE
TASKBAR
1. Customize the Taskbar’s Location and Appearance
Just as in older versions of Windows, you can customize the taskbar in Windows
10 in six different ways.
To customize the taskbar format, follow these steps:
1.
2.
3.
4.

Right-click on the Taskbar.
Click on Taskbar Settings.
Set how you want the taskbar to behave by checkmarking the available
settings.
Close the Taskbar dialogue screen.

2. Take Advantage of the New Timeline Feature
The new Timeline feature keeps track of every file you open and every web page
you visit (while in Edge browser only). You still manage your current tasks and
desktops as before, but now you can also access previous tasks up to 30 days later.
The Timeline should be enabled by default. However, if it is not, Open
Settings (Windows + I) > Privacy > Activity History on the left side of the window.
Then, look at the middle column of the Activity History window. To be able to use
the Timeline feature and everything it has to offer, you have to check the box that
says “Let Windows collect my activities from this PC.” Also, you have to select at
least one user account to use with the Timeline. The Timeline will then record and
show the activities that you performed while connected to that user account.
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Although the Timeline feature is associated with Task View, it is not necessary to
have the Task View on the Taskbar. Use the new keyboard shortcut Windows key
+ Tab to activate the feature.
3. Don’t have the Search Box add to the Clutter
To change the Search tool from the wide search box to the smaller circle, rightclick on the Search box that is showing, move up to Cortana, then over to Show
Cortana icon.
If neither the search box nor search icon is showing, right-click on the Taskbar
area, move up to Cortana, and select Show Cortana icon.
If Cortana is enabled (which is the default), both the search box and the small
circle will state: Ask me anything. The small circle icon is replaced by a small
magnifying glass icon when Cortana is disabled.
If Cortana is disabled, both the search box and the magnifying glass will state:
Search Windows. Internet searches will be handled by your favorite browser and
search engine.
4. Pin Important Apps to the Taskbar
Most of us like to make sure that anything we use frequently is easily accessible.
That’s why people place telephone numbers on speed dial.
Desktop or Taskbar shortcuts in Windows are like these real-life shortcuts because
they are excellent timesavers. By placing shortcuts to your frequently used files,
folders, and applications on your Desktop or Taskbar, you avoid having to hunt
around for them in the vast recesses of your computer.
You can find the target app listed after clicking the Start button. All the
applications stored on your computer will be listed here in alphabetical order. Once
you find the target application (it may be hidden in a file folder), right-click on it,
then click on More, then Pin to Taskbar. This action will place a shortcut icon on
your Taskbar.
5. Access 21 Special Controls from the Taskbar
Previously, when you right-clicked on an object on the Desktop, a vertical context
menu would appear which gave you a choice of actions to take. In Windows 10,
right-clicking the Start button produces an expanded and specialized set of 21
menu items. (To access the same set of specialized options, press Windows + X.)
Page 2 of 18

6. Choose which Special File Folders Appear on the Start Menu
The extreme left column of the Start menu (press Windows key) features the
options that are available to you by default. Each can be turned on or off,
depending upon which options you wish to use. To control the options, use
Windows key + I, then Personalization, then Start. Generally, you will want to
make sure that six of the options listed are turned off. You will want to keep Show
app list in Start menu turned on. Now click on choose which folders appear on
start and select from the 10 folders listed.
7. Add the Control Panel to the Taskbar
Do you find yourself accessing the Control Panel periodically to reset some of your
computer’s 50 settings? If so, why not place it on your Taskbar for easy access?
1.
2.
3.
4.
5.
6.

From the Search bar, type Control Panel.
Right-click on the Control Panel icon that appears at the top of the column.
Select Pin to Taskbar.
The Control Panel icon will appear on the Taskbar as a light blue rectangle.
Now you can access the control panel whenever you want without all the
mouse manipulation.
If you ever want to get rid of it, just right-click and select “Unpin from
taskbar”.

8. Pin File Explorer to the Taskbar
File Explorer is one of the most important locations within Windows 10. It is there
that you will locate all your drives, folders, and files. It is there that you will
determine where your folders and files are stored.
1.
2.
3.
4.
5.
6.

From the Search bar, type file explorer.
Right-click on the file explorer icon that appears at the top of the column.
Select Pin to Taskbar.
The file explorer icon will appear on the Taskbar as a manila folder.
Now you can access the File Explorer whenever you want without having to
remember the Windows + E shortcut!
If you ever want to get rid of it, just right-click and select “Unpin from
taskbar”.
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9. Pin Internet Explorer to the Taskbar
1.
2.
3.
4.
5.
6.
7.

From the Search bar, type Internet Explorer.
Right-click on the Internet Explorer icon that appears at the top of the
column.
Select Pin to Taskbar.
The Internet Explorer icon will appear on the Taskbar as the familiar E with
the gold band.
Now you can access the Internet Explorer whenever you want without
having to search for it from within the menu list.
If you ever want to get rid of it, just right-click and select “Unpin from
taskbar”.
You may wish to reposition the Internet Explorer icon so that it is in close
proximity to the Edge browser. (Any Taskbar icon can be dragged and
dropped to another position on the Taskbar.)

10. Add a Favorite Website to the Taskbar
Follow these steps to place a favorite website on the Taskbar:
1. Open your Edge browser.
2. In the Search the Web box, type the address of the target website.
3. Once you have accessed the website from within the Edge browser, click on
the menu tab (3 horizontal dots) in the upper right corner of the browser
window.
4. Click on Pin this page to the taskbar.
5. Your favorite website will now appear on the taskbar.
11. Add a Favorite Website to Your Apps Menu
Follow these steps to place a favorite website on the Apps list:
1. Open your Edge browser.
2. In the Search the Web box, type the address of the target website.
3. Once you have accessed the website from within the Edge browser, click on
the menu tab (3 horizontal dots) in the upper right corner of the browser
window.
4. Click on Open with Internet Explorer.
5. After the Website automatically arrives in Internet Explorer, click on the cog
wheel in the upper right corner of the Internet Explorer browser window.
6. Click on Add site to Apps.
7. The website will appear in the Apps menu (tap the Windows key to verify)
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12. Show Important Application Icons (anti-virus and anti-malware
programs) on the Taskbar
You can easily tweak which application icons appear in the Taskbar’s systray.
1. Right-click any open area on the Taskbar and click “Taskbar Settings.”
2. On the taskbar settings page, scroll down toward the bottom and click the
Select which icons appear on the taskbar link.
3. You’ll see a list of application icons. Toggle each one on or off to suit your
needs. As you toggle them, the representative icons will either appear or
disappear from the system tray.
13. Show Important System Icons (clock, volume, network, etc.) on the
Taskbar
You can easily tweak which system icons appear in the Taskbar’s systray.
1. Right-click any open area on the Taskbar and then click “Taskbar Settings.”
2. On the taskbar settings page, scroll down toward the bottom and click the
Turn system icons on or off link.
3. You’ll see a list of system icons. Toggle each one on or off to suit your
needs. As you toggle them, the representative icons will either appear or
disappear from the system tray.
14. Determine which Quick Actions you want to have access to via the Action
Center (Windows + A).
The Action Center (located in the far right corner of the Taskbar) gives access to
frequently used settings called Quick Actions (of which there are 14). You can
easily collapse the settings tiles down to one row of four tiles using the Collapse
caret. To change which four Quick Actions appear when you do this, you can go to
Settings (Windows + I) >. System > Notifications & actions.
You can sort through the 14 options and turn off the functions to don’t think you
will need. You can then rearrange the ones you want to retain by dragging and
dropping the four most important ones to the top of the row. This strategy will
cause the top row to be prominently displayed in the Action Center (Win + A).
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SECTION TWO: WHAT YOU WILL WANT TO KNOW ABOUT THE FILE
EXPLORER

15. Get quick access to the files that matter most.
The Quick access page is the shortest route to files you've been working on and
folders you often use.
To make sure a folder shows up in Quick access, right-click the target folder and
then select Pin to Quick access. A pin icon shows you which folders you’ve
pinned, so it’s easy to tell them apart from the rest.
16. Unpin folders from quick access.
To unpin a folder from the Quick Access section, Open File Explorer (Windows
+E) and follow these steps:
1.
2.
3.

Click the Quick Access section.
Right-click the folder that you want to unpin.
Click Unpin from Quick Access. The selected folder is no longer listed in
Quick Access.

17. Make File Explorer always show the full path.
By default, the Title Bar will display your current location in the file system.
However, if it does not, follow these steps:
1. Press the Windows + E keyboard combination to open Windows Explorer.
2. Switch to the View tab.
3. On the right-hand side click on options and then select Change folder and
search options from the drop-down menu.
4. When the Folder Options dialog opens, switch over to the View options.
5. Here you will need to click the Display the full path in the title bar check
box.
6. Click OK.
18. Enable and use the Preview Pane.
In File Explorer, you can enable a Preview pane that is shown on the right side of
the window. As the name implies, you can use it to preview the contents of certain
types of files (text, images, and videos). For example, if you select an image file in
File Explorer, you can see a preview of it; if you select a text file, you can preview
its contents.
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To enable the Preview pane, Open File Explorer (Windows +E) and follow these
steps:
1.
2.
3.

In the File Explorer window, click the View tab.
In the Panes section, click the Preview Pane button. The Preview pane is
added to the right side of the File Explorer window.
Select several files one by one. You can preview their contents in the
Preview Pane if they are text, images, or videos.

To disable the Preview pane, just follow the first two steps above, but deselect the
Preview Pane button.
19. Enable the Navigation Pane if it is disabled.
The Navigation pane is shown by default on the left side of the window. As the
name implies, you can use it to quickly jump to different locations on your
computer. When the Navigation pane is disabled and you start File Explorer, either
Quick Access or This PC is loaded, depending on your start location for File
Explorer. Without the Navigation pane enabled, you will find that navigating
around your computer will be difficult.
If the Navigation pane is missing, follow these steps to restore it:
1.
2.
3.
4.

Open File Explorer (Windows +E).
Click the View tab.
In the Panes section, click the Navigation Pane button. The Navigation Pane
menu appears.
In the menu, click Navigation Pane. It is an on/off toggle. The Navigation
pane (the entire left column) will appear/or not appear at the left side of the
File Explorer window.

20. Use Views to better examine your folders’ contents.
When you first browse a folder, File Explorer automatically applies a view that’s
optimized for the contents of that folder. However, the Ribbon has a number of
view options in the Layout section of the View tab:
• Details: For each file and folder, the Details view shows several columns
with information, such as Name, Date Modified, Type, and Size. Each file
has its own small icon that represents the file type.
• Content: Each file and folder appears on a separate row, where you see
detailed information about it, such as the date the file was last modified, its
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size, its author, and its length (for audio and video files). For picture and
video files, you see a small preview of the content rather than a file icon.
• List: Displays a simple list of folders and files, each with an identifying icon.
• Tiles: Displays a medium-size icon representing each file and folder, along
with information about their types and sizes.
• Extra-large icons: Displays extra-large icons that are representative of the
contents of each file. For pictures and video, you see a preview of each file.
• Large icons: Displays large icons that are representative of the contents of
each file. For pictures and videos you see a preview of each file.
• Medium icons: Displays medium icons that are representative of the
contents of each file. For pictures and videos you see a preview of each file.
• Small icons: Displays small icons that are representative of the contents of
each file.
You can easily switch between these views by clicking on them.
File Explorer remembers the last view that you used for a folder and applies it the
next time you open it.
21. Sort files and folders.
File Explorer offers the Sort tool for sorting the files and folders that you’re
viewing based on criteria such as their name, type, size, authors, and more. To sort
the files within a folder, Open File Explorer (Windows +E) and follow these steps:
1.
2.
3.
4.

Navigate to the folder that you want to sort.
Click the View tab on the Ribbon.
In the Current View section, click the Sort By button.
Click the sorting criteria that you want to use to apply it. The files and
folders for your current location are now sorted using the criteria you
selected.

22. Group files and folders
With File Explorer, you can group the files and folders that you’re viewing based
on criteria such as their name, type, size, authors, date, and more. To group the
files within a folder, Open File Explorer (Windows +E) and follow these steps:
1.
2.
3.

Navigate to the folder whose contents you want to group.
Click the View tab on the Ribbon. The View tab is shown.
In the Current View section, click the Group By button. The Group By menu
appears.
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4.

Click the grouping criteria that you want to use to apply it. The files and
folders for your current location are now grouped using the criteria you
selected.

23. Customize File Explorer with folder options
You can reconfigure certain ways that File Explorer works. All the configuration
settings are in a window named Folder Options. This window has three tabs filled
with settings. Here’s how to access the Folder Options window, browse its settings,
change them, and apply your desired configuration:
1.
2.
3.

4.
5.

6.
7.
8.
9.

Open File Explorer (Windows +E).
Click File. The File menu appears.
Click Change Folder and Search Options. The Folder Options window
appears at the General tab. Here are settings for browsing folders in File
Explorer, opening an item in File Explorer, and whether to show recently
used files and folders in Quick Access.
In the General tab, change the settings that you are interested in.
Click the View tab. Here you will find settings for viewing files and folders
in File Explorer. The list of settings is long. Browse through the list and read
what they do. Each name is self-explanatory.
Change any advanced settings that you want.
Click the Search tab. Here you find settings for using search in Windows 10
and in File Explorer.
Change how search works.
To apply your settings, click OK.

24. Use check boxes to select files and folders.
You can set File Explorer to display check boxes near the name of each file and
folder. You can then use these check boxes to select files and folders.
To enable check boxes in File Explorer, follow these steps:
1.
2.
3.

4.

Open File Explorer (Windows +E).
Click the View tab on the Ribbon.
In the Show/Hide section, click Item Check Boxes. Check boxes are now
shown each time you move your cursor on top of a file or folder. Click the
check box to select that item.
To disable the check boxes, follow the preceding steps.
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5.
6.

The Item Check Boxes will be either On or Off, depending upon how you
have set it.
Close File Explorer.

25. Clear File Explorer’s history of recently used files and folders.
By default, File Explorer remembers all the files and folders that you’ve accessed
and displays them in different places, like in Quick Access. If you want to clear
your history of accessed files and folders, Open File Explorer (Windows +E) and
follow these steps:
1.
2.
3.
4.

Click File. The File menu appears.
Click Change Folder and Search Options. The Folder Options window
appears.
In the third panel from the top (Privacy), click on the Clear button.
Click OK.

26. Maximize or minimize the ribbon in File Explorer.
By default, the Ribbon is minimized in File Explorer. If you find it useful and you
want to have it available, you may want to maximize it permanently.
Here’s how to maximize or minimize the Ribbon in File Explorer:
1.
2.

3.

Open File Explorer.
Press the Ctrl key + F1. This action acts like an on/off toggle button. If the
ribbon is minimized, it will automatically become maximized. If the ribbon
is maximized, it will automatically become minimized.
An alternative toggle button appears as an up arrow/down arrow on the far
right side of the Menu Bar.
File Explorer remembers whether the Ribbon was minimized or maximized
the last time you closed it and will open it that way the next time you open
File Explorer.

27. Find files in File Explorer using search.
The name of the search bar, which is located in the upper-right corner of the File
Explorer window, always starts with “Search,” followed by your current location
in File Explorer. This search bar functions differently from the search bar found on
the taskbar. First, you can use File Explorer’s search bar only to search for onPage 10 of 18

board files and folders. Also, the search is performed only in your current location.
For example, if you’re in Quick Access and you type the name of a file, Windows
10 searches for it only in the locations found in Quick Access. Similarly, if you go
to the Pictures folder and you type the name of a file, Windows 10 searches for it
only in the Pictures folder.
Here’s an example of a search:
1.
2.
3.
4.

5.
6.
7.

8.

Click on This PC in File Explorer’s left column.
Double-click the C drive, usually named Local Disk (C).
In the search bar at the top-right corner of the File Explorer window, type
wordpad.
Press Enter. A progress bar appears at the top of the File Explorer window
until the search finishes. The results returned are all from the C drive of your
computer. The total number of files that contain the word wordpad on the
hard drive C are listed in the lower left corner of the window.
Now, click the Documents folder in the This PC section.
In the search bar, type a different filename, one that’s found in your
documents.
Press Enter. The results returned are from the Documents folder only, not
from other locations on your computer. Also, because you’re searching in a
location that’s indexed by Windows 10, you receive the results much faster
than when you searched the entire drive.
Close File Explorer.

28. Move a file or folder in File Explorer.
You can move one or more files or folders to another location several ways. One
way is to use the Cut and Paste commands. To do so, open File Explorer and
follow these steps:
1.
2.
3.
4.
5.
6.

Browse to the target file’s or folder’s location and select it by right-clicking
on it.
In the dropdown menu that appears, click on the Cut button.
Browse and right-click on the folder where you want to move that folder or
file.
In the dropdown menu that appears, click on the Paste button.
The selected folder or file is now in the new folder and has been removed
from its original location.
Close File Explorer.
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29. Create a folder in File Explorer
You can create as many folders as you want, either directly on a drive on your
computer or within other folders. Using multiple folders enables you to better
organize your files, so create as many as you need. To create a folder, open File
Explorer and follow these steps:
1.
2.
3.
4.
5.
6.

Go to the location where you want to create the folder. It can be a drive on
your computer or another folder.
Right-click on the target folder and then click on New Folder from the
dropdown menu.
A new folder is created with the name New Folder.
Type the name that you want for the newly created folder.
Press Enter or click somewhere else in the File Explorer window. The newly
created folder now has the name that you typed.
Close File Explorer.

30. Create a shortcut to a file or folder in File Explorer
You may want to create a shortcut to a file or folder and place it on the Desktop for
quick access or in some other location that you go to frequently. To create a
shortcut, open File Explorer and follow these steps:
1.
2.

Locate the file for which you want to create a shortcut.
Right-click on that file and in the menu that appears, select one of these
options:
• Click Create Shortcut. This creates a shortcut in the folder where the file is
found. You can then move the shortcut to another folder.
• Click Send To; then click Desktop (Create Shortcut). This creates a
shortcut to the file on the Desktop.

Shortcuts are references to the files and folders that they point to. When you delete
a shortcut, the item it points to remains on your computer. On the other hand, if
you delete or move the file or folder it points to, the shortcut doesn’t work.
31. Select multiple files or folders in File Explorer
When you are working with files and folders in File Explorer, sometimes you may
want to select more than one item. For example, you may want to select a group of
files and delete them as one action or select multiple folders and move them to
another folder. Here’s the quickest way to select items in File Explorer:
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1. Click the first file or folder that you want to select.
2. Press and hold the Ctrl key on your keyboard.
3. With the Ctrl key still pressed, click each file and folder that you want to
select.
4. Release the Ctrl key after you select the items. Each of the selected items is
highlighted with a blue bar in File Explorer. Now you can apply commands
(via right-click on any one of them) like Cut, Copy, or Delete to all selected
items.
32. Check folder sizes at a glance.
When you view Windows Explorer (Windows key + E) in Details view, the Size
column shows the space consumed by individual files, but provides no information
on the size of folders.
To find the total size of any folder (or nested folder) contents, right-click on the
target folder, and then click on Properties. The total size of that folder’s contents
will appear.
This information is especially important if you are planning to copy the entire
contents of a folder to another medium, e.g., a flash drive.
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SECTION THREE: WHAT YOU WILL WANT TO KNOW ABOUT THE
EDGE BROWSER
33. Work with multiple tabs in Windows Edge
Tabbed browsing is an Edge feature that allows you to open multiple websites in a
single browser window. You can open web pages in new tabs and switch back and
forth between the pages by clicking their tabs at the top of the page.
Here’s how to do so:
1.
2.
3.
4.
5.
6.
7.
8.

Open Windows Edge.
Type the web address of your first selection in the Search the web box that
appears near the top of the home page. Press Enter.
Now click on the + at the top of the page and type the web address of your
second selection into the Where to Next box and press Enter.
Type the web address of your second selection and press Enter.
To add tabs for additional websites, simply follow steps #2 and #3.
You can now bounce back and forth from one website to another by clicking
on the representative tab.
To close one of the websites, click on the X for the tab that the website
represents.
When you are done, close the browser.

34. Establish your own Home Page
Your browser’s home page is the webpage that appears when you access Windows
Edge. By default, the home page is the one supplied by Microsoft.
Follow these steps to establish your own home page:
1. Open Windows Edge.
2. Click on the three dots that appear in the upper right corner of the home page
menu.
3. Click on Settings.
4. Click on Open Microsoft Edge with…a specific page or pages.
5. Enter the URL (specific web address) of your desired home page.
6. Click on the save button.
7. Now when you close and reopen the browser, your new home page will
appear.
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35. Set the Home Button
You’ll find a variety of other ways to customize Edge’s interface in its Settings
menu. For example, you can enable a Home button to quickly take you back to
your preferred home page.
1.
2.
3.
4.
5.

Open Microsoft Edge.
Click the three dots at the right top.
Click Settings.
Scroll down to View Advanced Settings (If you have version 1809, click on
the General tab in the left column.)
At the top of the next page, make sure Show the home button is enabled.

36. Search Faster in the Address Bar
Enter your search in the address bar that appears either at the top of the page or the
middle of the page, depending on how you have your home page organized. You’ll
get search suggestions, results from the web, your browsing history, and favorites
right on the spot.
37. The HUB is a collection of your favorites, reading list, browsing history,
and current downloads
The Hub as the place where Microsoft Edge keeps the things you collect from the
web. Select Hub (a star dissected by three horizontal lines near the upper right
corner of the window) to view your favorites, favorites bar, reading list,
browsing history, and current downloads.
38. Save Web based articles to read later
1. The Reading list gives you a place to save web articles you want to read
later.
2. Go to the target article.
3. Select from the Menu bar, then Reading list.
4. Then Add.
5. Later, when you’re ready to read the article, go to the Hub and select
Reading list . This feature will let you separate your web reading list from
your web favorites.
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39. Read a web article in a font size that you prefer.
1. Open the web article that you want to read.
2. Select the book icon in the address bar to turn on reading view.
3. Your reading material will be brought front-and-center.
4. You can even change the reading view style and font size to suit your
mood—including have the selection read to you.
40. Share a favorite article with others on social media.
The Edge browser has an integrated sharing feature with a Share button (indicated
by a small arrow that swoops to the right) on its toolbar. Tapping the Share button
will open the system Share panel. You can extend the list here and share to more
services by installing the appropriate apps from the Windows Store.
For example, if you want to share on Facebook, install the Facebook app. If you
want to share on Twitter, install the Twitter app. This provides you with an easy
way of sharing web pages without any browser extensions.
You can also tap the title of the page in the Share panel and choose to share a
screenshot of the current web page rather than a link to it.
41. Browse the web using inprivate browsing
InPrivate Browsing in Windows Edge enables you to surf the web without leaving
a trail in your browser. This helps prevent others using your computer from seeing
what sites you visited and what you looked at on the web. When you start InPrivate
Browsing, Windows Edge opens a new browser window. The protection that is
provided is in effect only during the time that you use that window. You can open
as many tabs as you want in that window, and they’re all protected. However, if
you open another browser window, that window isn’t protected by InPrivate
Browsing. While you’re surfing the web using InPrivate Browsing, Windows Edge
stores some information like cookies and temporary Internet files so that the web
pages you visit work correctly. However, at the end of your InPrivate Browsing
session, this information is discarded.
Here’s how to start InPrivate Browsing in Edge:
1.
2.
3.

Open Windows Edge. The window that opens is not protected by InPrivate
Browsing.
Click the More button (the three horizontal dots in the upper right corner).
Click on New InPrivate window.
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4.
5.

On the next screen, type the name of the website you wish to browse in
private.
When you arrive at that website, note that the word “inprivate” will appear
in the upper left corner of the screen. Navigate the web as usual in this
window.

42. Pin to Start
Edge allows you to open the menu (designated by … three dots in the upper right
corner) and select Pin to Start to pin the current web page to the Start menu as a
tile, allowing you to open it quickly in Edge.
43. The dark theme
Like many other modern Windows 10 apps, Edge includes a dark theme as well as
its default light theme. To activate it, open the menu (three dots in the upper right
corner), click on Settings, and then select “Dark” under “Choose a theme.”
44. Activate the Favorites Bar
You can activate the “Show the favorites bar” setting to get an always-present
toolbar for easier access to your favorite web pages.
To accomplish this, open the menu (three dots in the upper right corner), click on
Settings, then move down the list and confirm that Show the favorites bar is
toggled on.
45. Change the download location of a web link
By far the easiest way to change the download location is to right click a link to a
file you intend to download, then choose "Save Target As". You will then be
prompted with a "Save as" window, which will allow you to navigate to any folder
on your system to save the file.
46. Turn on autofill
From within your Edge browser, Autofill makes suggestions in a pull-down menu
as you type information into your search bar. If this feature has been disabled in
your Edge browser, you will certainly want to turn it back on. Follow these steps to
do so:
1. Open Microsoft Edge.
2. Click on the Menu icon (three horizontal dots near the upper right corner).
3. Click on Settings.
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4. Click on View Advanced Settings.
5. Turn on the toggle switch to Show search and site suggestions as I type.
47. Add frequently used web pages to your favorites
When you find a Web page that you would like to add to your Favorites for quick
access later on, follow these steps.
1.
2.
3.
4.
5.
6.

Open the Edge browser.
Display the page that you would like to store as a Favorite.
Click on the STAR on the menu bar.
Assign a name to the favorite.
Click on either Favorites or Favorites Bar.
Favorites that you pin to the Favorites Bar will appear on a bar near the top of
the browser.

48. Reset Edge when it becomes sluggish
Pinpointing the exact reason for sluggish performances from your browser is
difficult. However, resetting Edge to its original settings can help clear corruptions
that can impact performance.
Resetting Microsoft Edge is not like resetting other browsers. Edge is a part of the
Windows operating system, and cannot be uninstalled. There are different ways to
tackle this problem, but you should try the basic method first.
1. Open the “Settings” menu by clicking the three horizontal dots in the upper
right corner of the Edge window and choose “Settings.” (If 1809 has been
installed on your computer: click on Privacy and Security.)
2. Under Clear browsing data, click “Choose what to clear” and then click “Show
more.” There are a lot of data types here. Select them all and click “Clear.”
Restart your PC and re-open Edge for a clean slate.
49. Pin a website to the apps menu
1.
2.
3.
4.
5.
6.
7.

Open Edge from the Taskbar.
Access the target website.
Click on the three horizontal dots in the upper right corner of the page.
Click on Open with Internet Explorer.
Click Add site to apps.
Click Add.
The website will now appear in the Menu bar in alphabetical order.
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